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Глава 1

Введение

Eureka - редактор карт классического DOOM и основанных на его движке игр - Heretic и Hexen.
Поддерживает работу в Linux, Windows и OS X.

Проект находится по адресу http://eureka-editor.sourceforge.net

Автор Eureka - Andrew Apted. Автор мануала и сборщик - Wesley Werner. Автор версии на русском
языке - Arbars Zagadkin.

1.1 Мануал

Если вы заметили ошибку, прошу сообщить о ней здесь.

По поводу ошибок в переводе, сообщайте о них сюда.

Хочешь помочь с улучшением проекта? Сделай форк репозитория автора оригинала, или перевода и
отправь pull request.

Также есть PDF-версия данного мануала.

1.2 Лицензия

Данный мануал распространяется под лицензией Creative Commons Attribution-ShareAlike 4.0
International License.
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Глава 2

Установка

2.1 Системные требования

Файл IWAD, или «Internal (внутренний) WAD», содержит в себе карты, текстуры, звуки и прочие
данные, которые идут по-умолчанию. Ты можешь использовать DOOM.WAD или DOOM2.WAD, если
они у тебя есть.

В качестве альтернативы можно воспользоваться файлами проекта Freedoom . Freedoom распростра-
няется под свободной BSD лицензией и имеет в своём составе уровни, графику, звуки и музыку, и
совместим с любым клаччическим Source-портом. Достаточно скачать и распаковать архив с файлами
в любое удобное для тебя место. В случае с GNU / Linux можно положить файлы в каталог ~/.eureka/
iwads/ или установить игру из репозиториев, и редактор автоматически их найдёт и подключит.

2.1.1 Движок Doom

Для того, чтобы тестировать карты, тебе понадобится движок Doom (source-порт). На выбор есть
несколько вариантов:

• Chocolate Doom - создан для сохранения опыта игры в оригинальном Doom на современных ОС.
Неплохой вариант для тестов.

• PrBoom - продвинутый движок с кучей настроек совместимости. Стандарт для записи и просмот-
ра демок.

• Crispy Doom - минималистичное решение с парой плюшек.

• GZDoom - продвинутый и модифицируемый движок с кучей особенностей, включая нестандарт-
ные. На первых порах привязывать карты к данному порту не рекомендуется.
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2.2 Windows

Для скачивания последней версии редактора переходим на страницу проекта и жмём на большую
кнопку «download». Распаковываем куда-нибудь архив и кликаем на eureka.exe.

2.3 GNU / Linux

По идее, Eureka уже есть в репозиотриях большинства популярных дистрибутивов. Но если нужна
самая свежая версия, то придётся собирать из исходного кода.

• переходим на страницу загрузки проекта

• скачиваем и распаковываем eureka-*-source.tar.gz

• ставим необходимые для сборки пакеты:

$ sudo apt-get install \
build-essential \
libfltk1.3-dev \
libxft-dev \
libxinerama-dev \
libfontconfig1-dev \
libjpeg-dev \
libpng12-dev \
zlib1g-dev \
xdg-utils

• собираем исполнимый файл

$ cd eureka*
$ make

• устанавливаем Eureka

$ sudo make install

6 Глава 2. Установка
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Глава 3

Интерфейс пользователя

Eureka обладает двумя основными режимами работы с картой - 2D и 3D. Переключаться между ре-
жимами можно клавишей tab.
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2D вид используется, собственно, для маппинга - построения уровней и расстановки предметов на
них

3D вид используется для предпросмотра уровня при калибровке освещения, выборе текстур пола и
потолка

3.1 Движение и масштабирование

Для перемещения в 2D виде используются:

• Колёсико мыши - масштабирование

• Средняя кнопка мыши (под колёсиком) - захват и перемещение рабочей поверхности

• Клавиша home - отмасштабировать рабочую область так, чтобы была видна вся карта целиком

3.2 Камера

Стрелочка в 2D виде показывает текущее положение 3D камеры.

• Клавиша ' (одиночная кавычка) в 2D виде переносит 3D камеру в точку, на которой находится
курсор.

8 Глава 3. Интерфейс пользователя
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• Клавиша end в 2D виде определяет центром карты координаты 3D камеры.

В 3D управлять перемещением камеры можно следующими способами:

• Колёсико мыши - вперёд / назад

• Удерживать СКМ и двигать вправо / влево - поворот камеры

• Удерживать СКМ и двигать вперёд / назад - поднимать / опускать камеру

3.3 Сетка координат

Включать сетку координат можно в выпадающем меню Grid на нижней панели, или клавишей g.
Быстро переключаться между размерами ячеек можно клавишами 0-9 в врехнем ряду клавиатуры.

Переключаться между режимами с привязкой к сетке и без можно клавишей f.

3.3. Сетка координат 9
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3.4 Режимы отрисовки

В меню View / Sector Rendering можно выбрать режим отрисовки секторов.

10 Глава 3. Интерфейс пользователя
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3.4.1 Полы

Сектора будут отрисовываться с текстурой пола.

3.4. Режимы отрисовки 11
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3.4.2 Потолки

Сектора будут отрисовываться с текстурой потолка.

12 Глава 3. Интерфейс пользователя
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3.4.3 Освещённость

Данный режим показывает уровень освещённость секторов.

3.4. Режимы отрисовки 13
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3.4.4 Звук

Этот режим показывает, как распространяется звук. Наводим курсор на нужный сектор, чтобы уви-
деть, как будет распространяться звук.

14 Глава 3. Интерфейс пользователя
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3.5 Поиск и замена

Панель поиска и замены открывается через пункт меню View / Find или сочетанием клавиш control-f.

Можно искать предметы, текстуры линий, плоскости полов, линии по типу (спэшлу) или секторы по
типу.

3.5. Поиск и замена 15
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Глава 4

Работа с проектом

WAD-файл может содержать несколько карт, которые нумеруются согласно того порядка, который
заложен в выбранном IWAD.

Для Doom1 или Freedoom: Pase 1 это 4 эпизода по 9 карт в каждом: E1M1-9, E2M1-9, E3M1-9 и E4M1-9.

Для Doom2 или Freedoom: Phase 2 это 32 карты: MAP01 - MAP32.

Данные мануал затачивается под Freedoom: Pase 1.

4.1 Создание нового WAD

Через пункт меню File -> New Project или сочетание клавиш Ctrl+N вызываем диалогое окно со-
хранения WAD, вбиваем имя файла, выбираем место, и кликаем «OK».

Затем, настраиваем новый проект:

• IWAD: выбираем freedoom1 из списка, жмём кнопку Find и указываем его местоположение.

• Source Port: выбираем boom (или тот, что нравится) из списка, жмём Setup и указываем место-
положение екзешника

• В случае с GNU / Linux, расположение исполняемого файла можно узнать с помощью команды
which prboom-plus.

Закансиваем настройку и кликаем OK.

17
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4.2 Открываем карту

Открываем окно выбора карты через пункт меню File -> Open Map или сочетание клавиш control-o.
В выпадающем еню выбираем пункт Find map in the PWAD above, в противном случае для выбора
будут доступны только карты из IWAD.

18 Глава 4. Работа с проектом
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4.3 Добавляем карту

Открываем окно добавления карты через пункт меню File -> Fresh Map. Розовым отмечены занятые
слоты, зелёным - свободные.

4.3. Добавляем карту 19
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4.4 Переименовываем карту

Через пункт меню File -> Rename Map можно изменить порядок карт, выбрав в диалоговом окне
новый слот.

Занятые слоты выбирать нельзя.

20 Глава 4. Работа с проектом
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4.5 Копируем карту

Пункт меню File -> Copy Map открывает окно, в котором выбираем слот для скопированной карты.

4.6 Удаляем карту

Пункт меню File -> Delete Map удалит текущую карту из WAD, запросив подтвердение.

4.7 Экспортируем карту

Пункт меню File -> Export Map поможет экспортировать карту в:

• новый WAD

4.5. Копируем карту 21
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• уже существующий WAD

Выбор файла, в который будет экспортирована карта

22 Глава 4. Работа с проектом
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Выбор слота, в который будет экспортирована карта

4.7. Экспортируем карту 23
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Глава 5

Базовые понятия

5.1 Вершины

Вершины соединяют линии сектора между собой.

• Жмём v в 2D виде для перехода в режим работы с вершинами

• ЛКМ на линии вставляет вершину

• ПКМ ставит вершину и включает режим рисования линий, в котором, продолжив жать ПКМ и
замкнув контур, мы получим сектор

25
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5.2 Линии

Линии делят карту на сектора. Также они используются для укзания различных экшонов.

Жмём l в 2D виде, чтобы попасть в режим работы с линиями.

26 Глава 5. Базовые понятия
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Также линия имеет лицевую и обратную стороны. Определить лицевую сторону линии можно по
короткой перепендикулярной линии, выступающей из середины.

5.2. Линии 27
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линия повернута лицевой стороной вниз

5.3 Сектора

Сектор - участок карты, очерченный несколькими линиями.

Жмём s в 2D виде для перехода в режим работы с секторами.

28 Глава 5. Базовые понятия
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5.4 Объекты

Объект нужен для обозначения игрока, монстра, предметов дектораций, бонусов, точек старта в муль-
типлеере и точек телепорта.

Жмём t в 2D виде для перехода в режим работы с объектами. space или ins вставляют новый объект
туда, куда указывает курсор.

5.4. Объекты 29
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5.5 Мульти-выбор

При необходимости, перейдя в 2D вид, можно выделять вершины, линии, сектора и объекты при
помощи:

• Клика по ним (при повторном клике по объекту выделение снимается)

• Выделения объектов рамкой, котрая появляется при зажатии ЛКМ

• Удерживая shift и ЛКМ - выделение рамкой нескольких объектов

Переключение между режимами работы с вершинами, линиями и секторами сохраняют выделение,
если это возможно.

5.6 Отмена выделения

Жмём ` (обратный апостоф) в 2D виде, и выделение со всех объектов снимается.

30 Глава 5. Базовые понятия
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5.7 Трансформация

У секторов, линий и вершин имеется возможность менять форму и размер.

5.7.1 Изменение размера

Менять размер объекта можно через меню Edit -> Scale Objects, или через клавишу F3, которая
вызовет диалоговое окно.

Выбраны 4 основных вершины

5.7. Трансформация 31
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Смещение вершин на 50% по оси X

32 Глава 5. Базовые понятия
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5.7.2 Вращение

ПО пункту меню Edit -> Rotate Object или нажатию F4 появится диалоговое окно вращения.

5.7. Трансформация 33
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Выбраны 4 основных вершины

34 Глава 5. Базовые понятия
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Вершины повёрнуты на 45 градусов

5.7. Трансформация 35
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5.8 Текстуры

5.8.1 Стороны

Стороны содержат в себе данные о расположении текстур линии, которые могут быть нижними,
средними и верхними.

Связь разных уровней стороны прекрасно илюстрируется отвратительным выбором текстур:
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Нижний уровень - COMPBLUE, средний - MIDGRATE, верхний - BRICK10

Смена текстур на стенах

• Переходим в 2D вид

• Включаем режим работы с линиями (l)

• Выделяем одну или несколько линий
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• Кликаем по кнопке текстуры «Front sidedef».Откроется браузер текстур.

• (опционально) Жмём tab и преезходим в 3D вид для просмотра изменений «вживую»

• Выбираем текстуру в окне браузера
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5.8.2 Текстуры пола и потолка

Переходим в режим работы с секторами и выбираем нужный сектор:
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Кликаем по кнопке текстуры. Откроется браузер:

Жмём tab и пререходим в 3D вид для просмотра изменений «вживую»:
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Выбираем текстуру в окне браузера
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Глава 6

Основы Маппинга

Примечание: ЛКМ: клик Левой Кнопкой Мыши, ПКМ: Клик Правой Кнопкой Мыши

Следуя данным основам, создаём новый проект в Eureka.

6.1 Добавляем комнату

Для того, чтобы было удобно рисовать комнаты, жмём f, чтобы привязать сектора к координатной
сетке, и g, чтобы она появилась. Также жмём клавишу 5 для задания размера ячейки сетки в 32
еденицы.

• Жмём tab и переходим в 2D вид

• Жмём v и переходим в режим работы с вершинами

• Жмём ПКМ и начинаем рисовать сектор. Продолжаем добавлять вершины ПКМ, пока не получим
нужный результат, и в конце замыкаем контур.
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Добавляем текстуры на стены

Жмём l и переходим в режим работы с линиями. Свежесозданные линии будут уже выделены. Если
же нет, то кликаем ЛКМ по каждой линии.
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• Наводим курсор мыши на новый сектор и жмём ' (апосотф), чтобы перенести туда камеру.

• Жмём tab и переходим в 3D вид

• Кликаем на стену перед нами и выбираем текстуру SLADWALL.
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Добавляем текстуры на пол и потолок

• Жмём tab и возвращаемся в 2D вид

• Жмём s и переходим в режим работы с секторами. Сектор, по идее, уже будет выделен. Если
нет - кликаем по нему ЛКМ.

• Жмём tab и переходим в 3D вид

• Кликаем по кнопкам текстур Floor и Ceiling , и выбираем текстуру FLOOR5_1.
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6.2 Соединение комнат

• Жмём tab и возвращаемся в 2D вид

• Жмём v для перехода в режим работы с вершинами

• Кликаем ПКМ на линии сектора, чтобы поставить там вершину, и тянем линию до соседнего сек-
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тора. Повторить 2 раза

• Проверяем расстояние между линиями, оно должно составлять 128 едениц - такова ширина тек-
стуры широкой двери

• По окончании имеем 2 соединенные комнаты.
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6.3 Управляем высотой потолка

• Жмём tab и возвращаемся в 2D вид

• Жмём s и возвращаемся в режим работы с секторами

• Выбираем нужный сектор
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• Жмём tab и переходим в 3D вид

• Кликаем по кнопкам + и - вплоть до получения нужного результата

• Как альтернативу, можно использовать клавиши []

50 Глава 6. Основы Маппинга



Eureka Documentation

6.4 Выравниваем текстуры

• Жмём tab для перехода в 3D режим

• Кликаем ЛКМ по стенам с кривыми текстурами

6.4. Выравниваем текстуры 51
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• Для выравнивания текстур жмём следующие сочетания клавиш:

– x: выравнивание по оси X влево

– y: выравнивание по оси Y влево

– z: выравнивание по осям X и Y влево

– shift-x: выравнивание по оси X вправо

– shift-y: выравнивание по оси Y вправо

– shift-z: выравнивание по осям X и Y вправо

• Как альтернативу можно воспользоваться меню по клавише F1.
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6.5 Автоматическое выравнивание

Если же нужно выровнить несколько стен, можно воспользоваться автовыравниванием:

• В 2D виде жмём l и переходим в режим работы с линиями

• Выделяем нужние линии

• Жмём shift-A и выравниваем все выделенные линии

• Приём работает и 2D, и в 3D режиме
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Примеры

7.1 Лестница
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7.1.1 Схема

7.1.2 Метод

• В режиме вершин ПКМ рисуем контур будущей лестницы:

• Режем прямоугольник на ступеньки:
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• В режиме секторов выбираем все ступеньки:

• Жмём пару раз клавишу поднятия пола . (точка)

• ЛКМ снимаем выделение с первой ступени:

• Повторяем предыдущие 2 шага, пока ступеи не закончатся:
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7.1.3 Загрузки

stairs.wad

7.2 Изогнутая лестница
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7.2.1 Схема

7.2.2 Метод

Рисуем контур будущей лестницы в режиме вершин:

7.2. Изогнутая лестница 59
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ЛКМ делим вершинами длинные стороны на отрезки, чтобы определить, где будут ступени:
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Жмём f для отвязки вершин от сетки координат, и начинаем двигать вершины так, чтобы получилось
что-то наподобие арки.
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Снимаем выделение со всех вершин (`) и выделяем только верхний ряд:
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Жмём shift-c (сформировать арку в 120 градусов):

7.2. Изогнутая лестница 63
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Повторяем предыдущий шаг с нижним рядом вершин и соединяем ПКМ оба ряда линиями:
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Переходим в режим секторов и, удерживая shift, выделяем ЛКМ сектора ступеней:
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Поднимаем ступени клавишей . (точка). ЛКМ снимаем выделение с крайних секторов:
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• Повторяем предыдущий пункт до тех пор, пока не дойдём до центра лестницы:

7.2. Изогнутая лестница 67
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7.2.3 На заметку

Операции по формированию арки есть и в меню на клавише f1. Тем не менее, в нём нет пункта для
арки в 120 градусов, так что придётся использовать сочетание клавиш shift-c.

68 Глава 7. Примеры



Eureka Documentation

7.2.4 Загрузки

curved-stairs.wad

7.3 Небо

7.3.1 Метод

Создать небо просто - нужно наложить на потолок текстуру F_SKY1.

Да и стены могут помочь создать неплохой вид:
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Для стен пониже, добавляем приграничный сектор с нужной высотой (на карте он подсвечен):
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Опускаем потолок приграничного сектора ([) и наслаждаемся видом широкого неба.

7.3.2 Загрузки

sky.wad
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7.4 Жертвенный алтарь

Используя концентрические круги мы построим жертвенный алтарь.

7.4.1 Метод

В режиме вершин рисуем нарезанный на равные отрезки прямоугольник:

Этот прямоугольник мы превратим в круг, используя инструменты формирования арки.

Выдели центральную пару точек и подвинь их на 1.9 по оси y :
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Снимаем выделение и выбираем пары точек с обеих сторон и двигаем их на 1.8 по оси y :
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Следующие пары точек двигаем на 1.7.
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И так до тех пор, пока не дойдём до края.

Каждую пару вершин мы двигали на одну десятую меньше предыдущей, это даёт нам общий контур
и задаёт направление вершин. Если мы будем формировать арку «от потолка», редактор нам выдаст
сообщение «strange shape».

Выделяем врешины из верхнего ряда и формируем арку с углом 180 градусов комбинацией клавиш
shift-d:
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Выделяем нижний ряд вершин и снова жмём shift-d:

Теперь у нас есть основа будущего алтаря:
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Переходим в режим секторов и выделяем наш круг. Сочетаниями control-c и control-v делаем копию.
Уменьшаем копию на 1.2 по осям x и y planes.

Переходим в 3D вид и видим, что вставленный сектор рисуется с артефактами, это потому что скопиро-
ванный сектор нужно соединить с комнатой. Наводим курсор на наш сектор (его контур подсветится),
и жмём пробел:
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Повторяем процедуру со вставкой кругов, уменьшая их на 1.4 и 1.6 по осям xy соответсвенно. Четырёх
кругов, по идее, может быть достаточно:
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Высоту каждого этапа, текстуры пола, потолка и стен алтаря выбираем по вкусу.

7.4.2 Загрузки

altar.wad
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7.5 Лужа с отходами

Токсичные отходы наносят урон игроку.

7.5.1 Метод

• Жмём v и переходим в режим вершин

• ПКМ рисуем русло
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• Жмём s и переходим в режим секторов

• Жмём ` и снимаем выделение

• Выделяем сектор нашей лужи с кислотой

• Кликаем по кнопке тексуры пола и задаём текстуру NUKAGE1

7.5. Лужа с отходами 81



Eureka Documentation

• Указываем тип сектора, кликнув по кнопке Choose

• Выбираем из списка тип Damage 5%
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• Жмём ` и снимаем выделение

• Выделяем сектора, которые будут берегами

• ПОоднимаем пол берегов, кликая по кнопке +

• Как вариант, можно поднять пол, нажимая клавишу .

7.5. Лужа с отходами 83
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7.5.2 На заметку

Как вариант, можно просто опустить русло клавишей , (запятая)

7.5.3 Загрузки

toxicpool.wad
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7.6 Двери

Двери, открываемые вручную, удалённо и кнопкой.

7.6.1 Строим дверь

Данный метод применим для создания основы дверей. На её основе можно создать дверь с кнопкой и
др. двери.

• Переходим в режим вершин (v)

• Соединяем два сектора проёмом

7.6. Двери 85
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• Меняем размер ячеек сетки координат клавишами 3-5

• Рисуем ПКМ 2 линии, параллельные проёму

• Переходим в режим линий (l) и выделяем переднюю и заднюю стороны двери
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• Т.к. двери выходят из потолка, выбираем передней верхней стороне текстуру ICKDOOR1.
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• Переходим в режим секторов(s) и выделяем сектор нашей двери
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• И опускаем потолок сектора до пола, используя кнопки +- возле иконки Ceiling или клавиши
[].

7.6. Двери 89
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7.6.2 На заметку

В случае, если одна из сторон двери оказалась лицевой стороной вовнутрь двери, в режиме линий
жмём F1 и выбираем в меню пункт „Flip“

7.6.3 Обычные двери

Обычные двери - двери, которые открываются тогда, когда с ней напрямую взаимодействует игрок.

90 Глава 7. Примеры



Eureka Documentation

• Переходим в режим линий (l)

• Выделяем обе стороны линий

• В графе Type выбираем тип линии 1 DR Open Door

Чтобы дверные треки (часть дверной коробки, по которой движется дверь) не двигались вслед за
дверью, нужно:

• Выделить линии треков

• Поставить галочки в окошки upper unpeg и lower unpeg

7.6.4 Запертые двери

Дверь данного типа открывается ключом соответствующего цвета - Синим, Жёлтым или Красным, и
создаётся также, как и обычная. При выборе типа линии обращаем внимание на цвет:
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7.6.5 Двери с кнопкой

Такие двери открывается при помощи кнопок, переключателей и пр.

• Переходим в режим вершин (v)

• ЛКМ ставим пару вершин рядом с дверью вдоль стены, должна получиться линия длиной в 64
еденицы
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• Переходим в режим линий (l) и выделяем получившуюся линию

• Выбираем для неё текстуру SW1GRAY
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• Задаём тип линии 63 SR Door Open

• Переводим курсор мыши на сетку, чтобы перенести фокус с панели настроек линий

• Жмём сначала ;, а затем f чтобы задать линии новый тэг

• Переходим в режим секторов (s) и выделяем сектор двери
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• Жмём сначала ;, а затем l, чтобы присвоить сектору двери последний использованный тэг

• Eureka подсветит линию и сектор, связанные одним тэгом:
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7.6.6 Загрузки

doors.wad
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7.7 Телепорты

Телепорт срабатывает при пересечении игроком линии с соответсвующим спэшлом. Тэг линии привя-
зывается к тому сектору, на который телепортируется игрок.

7.7.1 Платформа телепорта

• Рисуем сектор со стороной 64х64 еденицы

• Текстурой пола указываем GATE1, текстурой потолка - TLITE6_5
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• Переходим в режим линий (l)

• ЖМём сначала ;, а затем f, чтобы присвоить новый тэг всем четырём линиям. Отсюда игрок
будет телепортироваться.

• Задаём в поле Type тип линии 97 WR Teleport

Примечание: Телепорт срабатывает только тогда, когда линия направлена Лицевой стороной к
игроку, а Задней - внутрь сектора. Это было сделано специально, чтобы игрок, переходя линию, не
активировал ненароком другой телепорт.
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7.7.2 Место прибытия

• Назначаем тэг линий телепорта тому сектору, в который будем телепортироваться, нажимая
сначала клавишу ;, а затем l.

• Переходим в режим предметов (t), располагаем курсор мыши на секторе и жмём ins или пробел.
Указываем тип предмета Type 14 Teleport Exit (в браузере предметов отмечен как TFOG)

• Указываем стрелками угол предмета TFOG. Углом мы указываем, в какую сторону будет смот-
реть игрок после телепортации.

7.7.3 Загрузки

teleporters.wad
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7.8 Лифты

7.8.1 Метод

• Переходим в режим вершин и рисуем платформу лифта. Она должна быть вровень с поднятым
сектором:
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• Убеждаемся, что линии платформы повёрнуты лицевыми сторонами наружу, иначе лифт рабо-
тать не будет.

• Если линии стоят не так, как надо, переходим в режим линий, жмём F1 и выбираем в меню пункт
Flip:
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• Выделяем линию лифта, с которй будет взаимодействовать игрок:
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• Назначаем тип линии 62 SR Lower Lift

• Жмём сначала ; а затем f и назначаем линии новый тэг
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• Переходим в режим секторов (s) и выделяем сектор лифта

• Жмём сначала ; а затем l и назначаем сектору последний использованный тэг

7.8.2 Загрузки

lifts.wad

7.9 Ловушки

7.9.1 Примеры

Все примеры доступны для тестирования в файле traps.wad

7.9.2 Нежданчик 1-й (скрытая комната с монстрами)

Монстры находятся в скрытой комнате, отделённой дверью или панелью, которая открывается вне-
запно для игрока.
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• Рисуем скрытый сектор (А), добавляем туда монстров.

• Создаём дверь скрытого сектора (B).

• Закрываем дверь и придаём ей вид обычной стены (C).

• Задаём новый тэг сектору двери (B).

• Рисуем линию-триггер, которая будет открывать дверь комнаты с монстрами, и задаём ей тэг
двери (D).

• Задаём линии-триггеру тип 109 W1 Open and stay fast (D).
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7.9.3 Нежданчик 2-й (платформа с монстрами)

Монстры спускаются на платформах, скрытых потолком. Особенно неприятно, когда ты идёшь за
ключом в дальнем углу.

• Рисуем платформы и добавляем на них монстров (A).

• Поднимаем полы и потолки платформ (B), пока их пол не сравняется с потолком основной ком-
наты.

• Выбираем сектора платформ (A) и назначаем им новые тэги.

• Вставляем пару вершин в стену, чтобы получился отрезок в 64 еденицы для кнопки (C).

• Добавляем на отрезок текстуру кнопки или переключателя(C).

• Задаём тэг платформ линии с кнопкой (C).
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• Задаём линии с кнопкой (C) тип 23 S1 Floor down LEF.

7.9.4 Пресс («давилка»)

Потолок опускается, раздавливая игрока.

• Задаём сектору-прессу новый тэг (A).

• Рисуем линию-триггер и назначаем ей тэг сектора-пресса (B)..

• Задаём линии-триггеру (B) тип 6 W1 Crusher /fast
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Внимание: Быстрый пресс забирает здоровье понемногу, давая шанс на побег после удара. Мед-
ленный пресс даёт шанс на побег в начале, но если прозевал - умрёшь жуткой смертью.

7.9.5 Провал в подпол

Пол внезапно проваливается, и игрок попадает в комнату с монстрами.

• Рисуем сектор, который будет проваливаться под игроком (A).

• Задаём ему тэг (A).

• Добавляем скрытую комнату, куда игрок будет проваливаться, и опускаем её (B).

• Вставляем 2 вершины и создаём переключатель (C).
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• Задаём переключателю тэг (C) проваливающегося сектора (A).

• Задаём линии переключателя тип 123 SR Lift Lower /fast (C).

7.9.6 Ловушка-мышеловка

Запирая все пути к отступлению, уровень заставляет игрока расправляться с монтрами по-быстрому.

• Создаём дверь (A) и задаём ей новый тэг.

• Рисуем линию, которая запустит процесс закрытия двери (B), и задаём ей тэг двери.

• Задаём линии-триггеру тип 16 W1 Close for 30s
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7.9.7 Нежданчик 3-й, из телепорта

Монстры в секретной комнате, услышав шум стрельбы, начинают беситься и телепортируются на
уровень.

• Назначаем новый тэг сектору, из которого монстры будут телепортироваться в сектор (A).

• Ставим предмет Teleport exit (тип 14, под категорией «Player», сокращенно TFOG) в сектор
(A).

• Рисуем скрытую комнату, где будут стоять монстры (D).

• Соединяем основную комнату (A) со скрытой (D) отдушиной (B). Это поможет звуку проникнуть
в скрытую комнату и поднять шум среди монстров.

• Рисуем триггер-линию телепорта в скрытой комнате (C), назначаем ей тот же тэг, что и у основ-
ной комнаты (A), и задаём тип 97 WR Teleport.

7.9.8 Боевая телепортация

Монстры телепортируются из одного угла карты в другой, заставляя игрока конкретно понервничать.
Эта ловушка хорошо показана в Doom II, map 10, где нужно уворачиваться от Кибердемона.
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• Создаём линии-триггеры с типом Type 126 WR Teleport /mon (A).

• Задаём новый тэг линии-триггеру (A).

• Присваиваем тот же тэг сектору (B)

• Ставим предмет Teleport exit в секторе (B).

• При необходимости повторяем данные шаги для создания большего количества телепортов и
усложнения атак.

7.9.9 Токсичный сюрприз

Токсичные отходы заливают пол, нанося игроку урон во время движения.
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• Рисуем линию-триггер и задаём тип 37 W1 Floor down LEF /NXP (A).

• Также задаём линии-триггеру новый тэг (A).

• Задаём тот же тэг нашему сектору-ловушке (B).

• Сектор-ловушка(B) должен быть окружен сектором с кислотой (C).

• Сектор с кислотой (C) должен быть ниже опускающегося сектора (B).

• Задаём сектору с кислотой (C) тип 7 Damage 5% и текстуру NUKAGE1. При срабатывании
сектор (B) опустится до уровня сектора с уроном (C) и переймёт все его параметры (урон и
текстуру).
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7.10 Заготовки

Заготовки позволяют сэкономить время при создании карты благодаря простому копированию уже
готовых конструкций (дверей и пр).

При использовании заготовок нужно помнить о 2 вещах:

1. Копирование работает только в пределах одного WAD файла.

2. После вставки заготовки нужно объединить общие вершины.

Карту с заготовками можно расположить в неиспользуемом слоте.

7.10.1 Загрузки

Как основу для своего набора заготовок будем использовать файл prefabs.wad.
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7.10.2 Объединение вершин

Копируя заготовку в свободное пространство, к примеру дверь, необходимо объеденить её вершины с
основным сектором.

Выбрав заготовку двери в режиме секторов, жмём control-c:
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Открыв нужную нам карту, располагаем курсор мыши в нужном месте и вставляем заготовку
control-v:
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Перейдя в режим вершин, жмём ПКМ, чтобы соеденить вершины двери с комнатой:
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Если между дверью и комнатой дополнительный сектор не нужен, выделяем одну из вершин двери,
затем одну из вершин комнаты (порядок имеет значение) и объединяем:
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То же самое делаем и с другими вершинамя (выделяя сначала вершину двери):
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Всё, эта сторона двери готова:
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7.10.3 Объединение секторов

Процесс вставки одного сектора в другой требует иного способа объединения. Лестница - лишь один
из примеров.

Выбираем сектора заготовки. Используем комбинацию shift LMB, чтобы рамкой выделить все нужные
сектора:

Копируем, открываем нашу карту, и вставляем. Убеждаемся в том, что курсор мыши находится в
нужном месте:
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Переходим в 3D вид, видим наши артефакты, говорящие о необходимости объединения:

7.10. Заготовки 121



Eureka Documentation

Чтобы объединить сектора, снимаем выделение (`), наводим курсор на сектор комнаты и жмём space:
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Всё, теперь сектора лестницы объединены с сектором комнаты:
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Глава 8

Шпаргалка

Данная шпаргалка - список горячих сочетаний клавиш и кнопок мыши, которые используются в
Eureka.

• cheatsheet-ru.pdf

• cheatsheet-ru.ods
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